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SYLLABUS  
: 

Allied Paper II -COMPUTER APPLICATION IN BUSINESS 

Objective: 

To enable the students to know the importance of computer application in business. 
 

Unit I 

 
Computer – Meaning – Characteristics – Areas of application – Components – Memory control unit – Input and 

output devices – Ms Word – Creating word documents – creating business letters using wizards – editing word 

documents 

– Inserting objects – formatting documents – spelling and grammar check – word count – thesaurus, auto correct 
working with tables – opening, savings and closing documents – mail merge. 

 

Unit II 
 

Spread sheet – Spread sheet programmes and applications – Ms Excel and features – Building work sheets – 

entering data in work sheets, editing and formatting work sheets – creating and formatting different types of 
charts - application of financial and statistical function – creating, analyzing and organizing data – opening and 

closing work books – Introduction to Pivot tables. 

 

Unit III 
 

Fundamentals of Computerized accounting – Computerized accounting Vs manual accounting - Architecture 

and customization of Tally – Features of Tally – latest version – Configuration of Tally – Tally screens and 
menus – Creation of company – Creation of groups – Editing and deleting groups – Creation of ledgers – Editing 

and deleting ledgers – Introduction to vouchers – Vouchers entry – Payment vouchers – Receipt vouchers – 

Sales vouchers – Purchase vouchers – Contra vouchers – Journal vouchers – Editing and deleting vouchers. 

 

Unit IV 

 

Introduction to Inventories – Creation of stock categories – Creation of Stock groups – Creation of Stock items- 
Configuration and features of stock item– Editing and deleting stocks – Usage of stocks in Vouchers entry. 

Purchase orders – Stock vouchers – Sales orders – Stock vouchers – Introduction to cost 

– creation of cost category – Creation cost centers – Editing and deleting cost centers & categories – Usage of 
cost category and cost – centers in vouchers entry – Budget and controls – Creation of budgets – Editing and 

deleting budgets – Generating and printing reports in detailed and condensed format. 

 

Unit V 
 

Day books– Trial balance – Profit and Loss account – – Balance sheet. Ratio analysis, Cash flow statement – 

Fund flow statement – Cost center report – Inventory report - Bank Reconciliation Statement. 
 

 

Text and Reference Books (Latest revised edition only) 

 

 Computer Applications in Business – S.V. SrinivsasaVallabhan – Sultan Chand Publication. 

 Microsoft office – Jones Derek – Comdex Computer Publication. 

 Implementing Tally – K.K. Nandhani Publication, BPB Publication 

 Computer Application in Business – R. Paramasivam – S.Chand& Co., 

 Computer Application in Business: Dr.JosephAnbarasu, Learntech Press 
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INTRODUCTION 

A computer is a programmable machine designed to perform arithmetic and logical 

operations automatically and sequentially on the input given by the user and gives 

the desired output after processing.  

Computer components are divided into two major categories namely hardware and 

software. Hardware is the machine itself and its connected devices such as monitor, 

keyboard, mouse etc.  

Software is the set of programs that make use of hardware for performing various 

functions 

COMPUTER MEANING  

 

A computer is an electronic device   that   manipulates   information,   or   data.  

It   has   ability to store, retrieve, and process data. We may already know that we can 

use a computer to type documents, send email, play games, and browse the Web. We 

can   use   it   to   edit   or   create spreadsheets, presentations, and even videos. 

 

A Computer is an electronic machine with the following capabilities: 

 

 Accepts user supplied data and instructions using various input devices. 

 Performs arithmetic and logical operations using the given data 

 Presents the results of data processing to output devices. 

 Stores the data in storage devices 

 Executes the given data using a set of user instructions. 
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CHARACTERISTICS OF COMPUTERS 

The characteristics of computers that have made them so powerful and 

universally useful are speed, accuracy, diligence, versatility and storage 

capacity. Let us discuss them briefly. 

 SPEED 

 ACCURACY 

 DILIGENCE 

 VERSATILITY 

 STORAGE CAPACITY 

SPEED 

Computers work at an incredible speed. A powerful computer is capable 

of performing about 3-4 million simple instructions per second. As you know 

computer can work very fast. It takes only few seconds for calculations that we 

take hours to complete. Therefore, we determine the speed of computer in terms 

of microsecond (10-6 part of a second) or nanosecond (10 to the power -9 part 
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of a second). From this you can imagine how fast your computer performs work 

ACCURACY 

In addition to being fast, computers are also accurate. Errors that may occur can 

almost always be attributed to human error (inaccurate data, poorly designed system 

or faulty instructions/ programs written by the programmer) The degree of accuracy 

of computer is very high and every calculation is performed with the same accuracy. 

The accuracy level is determined on the basis of design of computer. The errors in 

computer are due to human and inaccurate data. 

 

DILIGENCE 

Unlike human beings, computers are highly consistent. They do not suffer from 

human traits of boredom and tiredness resulting in lack of concentration. Computers, 

therefore, are better than human beings in performing voluminous and repetitive jobs. 

A computer is free from tiredness, lack of concentration, fatigue, etc. It can work for 

hours without creating any error. If millions of calculations are to be performed, a 

computer will perform every calculation with the same accuracy. Due to this capability 

it overpowers human being in routine type of work. 

 

 

VERSATILITY 

Computers are versatile machines and are capable of performing any task 

as long as it can be broken down into a series of logical steps. The presence of 

computers can be seen in almost every sphere – Railway/ Air reservation, Banks, 

Hotels, Weather forecasting and many more. It means the capacity to perform 

completely different type of work. We  may use your computer to prepare payroll 

slips. Next moment We may use it for inventory management or to prepare 
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electric bills. 

STORAGE CAPACITY 

Today’s computers can store large volumes of data. A piece of information 

once recorded (or stored) in the computer, can never be forgotten and can be 

retrieved almost instantaneously. 

Power of Remembering: 

Computer has the power of storing any amount of information or data. Any 

information can be stored and recalled as long as you require it, for any numbers of 

years. It depends entirely upon how much data you want to store in a computer and 

when to lose or retrieve these  data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ecomputernotes.com/fundamental/information-technology/what-do-you-mean-by-data-and-information
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AREA OF APPLICATIONS 

 BUSINESS  

 BANKING 

 EDUCATION 

 MARKETING 

 HEALTH CARE 

 ENGINEERING DESIGN 

 COMMUNICATION 

 GOVERNMENT 

BUSINESS 

A computer has high speed of calculation, diligence, accuracy, 

reliability, or versatility which made it an integrated part in all 

business organizations. 

Computer is used in business organizations for: Payroll 

 Calculation 

 Budgeting 

 Sales Analysis 

 Financial Fore casting Managing 

 Employees Database Management 

 Stock 

BANKING 

 

Today banking is almost totally dependent on computer. 

 Banks provide online accounting facility, which includes 

current balances, deposits, overdrafts, interest charges, 

shares, and trustee records. 



  

8 

 

 

 ATM machines are making it even easier for customers to 

deal with banks. 

 

  

EDUCATION 

The computer has provided a lot of facilities in the education system. 

 The computer provides a tool in the education system known as 

CBE Computer Based Education. CBE involves control, delivery, 

and evaluation of learning. 

 The computer education is rapidly increasing the graph of number 

of computer students. 

 There are number of methods in which educational institutions can 

use computer to educate the students. 

 It is used to prepare a database about performance of a student and 

analysis is carried out on this basis. 

MARKETING 

In marketing, uses of computer are following: 

 Advertising - With computers, advertising 

professionals create art and graphics, write and revise 

copy, and print and disseminate ads with the goal of 

selling more products. 

 Home Shopping - Home shopping has been made 

possible through use of computerized catalogues that 

provide access to product information and permit direct 

entry of orders to be filled by the customers. 
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HEALTH CARE 

Computers have become important part in hospitals, labs, and dispensaries. 

The computers are being used in hospitals to keep the record of 

patients and medicines. It is also used in scanning and diagnosing 

different diseases. ECG, EEG, Ultrasounds and CT Scans etc., are 

also done by computerized machines. 

Some major fields of health care in which computers are used are: 

 

 

 Diagnostic System - Computers are used to collectdata 

and identify cause of illness. 

 Lab-diagnostic System - All tests can be done and 

reports are prepared by computer. 

 Surgery: Nowadays, computers are also used in performing surgery. 

ENGINEERING DESIGN 

Computers are widely used in engineering purpose. 

One of major areas is CAD Computer aided design. That 

provides creation and modification of images. Some fields are: 

 Structural Engineering - Requires stress and strain 

analysis for design of Ships, Buildings, Budgets, Airplanes 

etc. 

 Industrial Engineering - Computers deal with design, 

implementation and improvement of integrated systems of 

people, materials and equipments. 

 Architectural Engineering - Computers help in planning 

towns, designing buildings, determining a range of 
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buildings on a site using both 2D and 3D drawings. 

COMMUNICATION 

Communication means to convey a message, an idea, a picture or 

speech that is received and understood clearly and correctly by the person 

for whom it is meant for. Some main areas in this category are: 

 Email 

 Chatting 

 Usenet 

 FTP 

 Telnet 

 Video Conference 

GOVERNMENT 

Computers play an important role in government. Some major 

fields in this category are: Budgets 

 Sales tax department 

 Income tax department Male/Female ratio 

 Computerization of voters lists 

 Computerization of driving licensing system 

 Computerization of PAN card 

 Weather forecasting 
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Types  of computer: 

When most people hear  the word computer,  they think of  a personal computer 

such as  a desktop or laptop. However, computers come in many shapes and sizes, and 

they perform many different functions in our daily lives. When you withdraw cash 

from an ATM, scan groceries at the store, or use a calculator, you're using a type of 

computer. 

 

Desktop computer: 

Many people use desktop computers at work, home, and school. Desktop 

computers are designed to be placed on a desk, and they're typically made up of a few 

different parts, including the computer case, monitor, keyboard, and mouse. 

 

 

Laptop computer: 

The second type of computer you may be familiar with is a laptop computer, 

commonly called a laptop. Laptops are battery-powered computers that are more 

portable than desktops, allowing you to use them almost anywhere. 
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Tablet computer: 

 

Tablet computers or tablets are handheld computers that are even more portable 

than laptops. Instead of a keyboard and mouse, tablets use a touch-sensitive screen for 

typing and navigation. The iPad is an example of a tablet. 

 

 

 

 

.Other types of computer: 

 

Many of today's electronics are basically specialized computer, though we don't 

always think of them that way. Here are a few common examples. 

 

 Smart phones:    Many cell phones can do a lot of things computers 

can do, including browsing the Internet and playing games. They are 

often called smart phones. 

 Wearable: Wearable technology is a general term for a group of 

devices including fitness trackers and smart watches that are designed 

to be worn throughout the day. These devices are often called 

wearable’s for short. 
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 Game consoles: A game console is a specialized type of computer that 

is used for playing video games on your TV. 

 TVs: Many TVs now include applications or apps that let you access 

various types of online content. For example, you can stream video from the 

Internet directly onto your TV. 

 

 

Server 

A server is a computer that serves up information to other computers on a 

network. For example, whenever you use the Internet, you're looking at 

something that's stored on a server. Many businesses also use local file servers 

to store and share files internally 
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A generation of computers refers to the specific improvements in computer technology 

with time. In 1946, electronic pathways called circuits were developed to perform the 

counting. It replaced the gears and other mechanical parts used for counting in 

previous computing machines. In each new generation, the circuits became smaller 

and more advanced than the previous generation circuits. The miniaturization helped 

increase the speed, memory and power of computers. There are five generations of 

computers which are described below; 

First Generation Computer: 

 

The first generation (1946-1959) computers were slow, huge and expensive. In 

these computers, vacuum tubes were used as the basic components of CPU and 

memory. These computers were mainly depended on batch operating system and 

punch cards. Magnetic tape and paper tape were used as output and input devices in 

this generation; 

 

Some of the popular first generation computers are; 

o ENIAC ( Electronic Numerical Integrator and Computer) 

o EDVAC ( Electronic Discrete Variable Automatic Computer) 

o UNIVACI( Universal Automatic Computer) 

o IBM-701 

o IBM-650 

Second Generation Computer: 

 

The second generation (1959-1965) was the era of the transistor computers. 
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These computers used transistors which were cheap, compact and consuming less 

power; it made transistor computers faster than the first generation computers. In this 

generation, magnetic cores were used as the primary memory and magnetic disc and 

tapes were used as the secondary storage. Assembly language and programming 

languages like COBOL and FORTRAN, and Batch processing and multiprogramming 

operating systems were used in these computers. 

 

Some of the popular second generation computers are; 

 IBM 1620 

 IBM 7094 

 CDC 1604 

 CDC 3600 

o UNIVAC 1108 

Third Generation Computer: 

The third generation computer used integrated circuits (ICs) instead of 

transistors. A single IC can pack huge number of transistors which increased the power 

of a computer and reduced the cost. The computers also became more reliable, efficient 

and smaller in size. These generation computers used remote processing, time-sharing, 

multi programming as operating system. Also, the high-level programming languages 

like FORTRON-II TO IV, COBOL, PASCAL PL/1, ALGOL- 68 were used in this 

generation. 

Some of the popular third generation computers are; 

 IBM-360 series 

 Honeywell-6000 series 

 PDP(Personal Data Processor) 

 IBM-370/168 

 TDC-316 
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Fourth Generation Computer: 

The fourth generation (1971-1980) computers used very large scale integrated 

(VLSI) circuits; a chip containing millions of transistors and other circuit elements. 

These chips made this generation computers more compact, powerful, fast and 

affordable. These generation computers used real time, time sharing and distributed 

operating system. The programming languages like C, C++, DBASE were also used 

in this generation. 

Some of the popular fourth generation computers are; 

 DEC 10 

 STAR 1000 

 PDP 11 

 CRAY-1(Super Computer) 

 CRAY-X-MP(Super Computer)  

Fifth Generation Computer: 

In fifth generation (1980-till date) computers, the VLSI technology was 

replaced with ULSI (Ultra Large Scale Integration). It made possible the production 

of microprocessor chips with ten million electronic components. This generation 

computers used parallel processing hardware and AI (Artificial Intelligence) software. 

The programming languages used in this generation were C, C++, Java, .Net, etc. 

Some of the popular fifth generation computers are; 

 Desktop 

 Laptop 

 Note Book 

 Ultra Book 

 Chrome Book  
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Multitasking: 

Multitasking is one of the major advantages of computer. Person can perform 

multiple tasks, multiple operations; calculate numerical problems within few seconds. 

Computer can perform trillion of instructions per second. 

Speed: 

Now computer is not just a calculating device. Now a day’s computer has very 

important role in human life. One of the main advantages of computer is its incredible 

speed, which helps human to complete their task in few seconds. All the operations 

can be performed very fast just because of its speed else wise it takes a long time to 

perform the task. 

Cost/ Stores huge amount of data: 

It is a low cost solution. Person can save huge data within a low budget. 

Centralized database of storing information is the major advantage that can reduce cost. 

Accuracy: 

One of the root advantage of computer is that can perform not only calculations 

but also with accuracy. 

Data Security: 

Protecting digital data is known as data security. Computer provide security 

from destructive forces and from unwanted action from unauthorized users like cyber 

attack or access attack. 

 

 

http://ecomputernotes.com/fundamental/what-is-a-database/advantages-and-disadvantages-of-dbms
http://ecomputernotes.com/fundamental/information-technology/what-do-you-mean-by-data-and-information
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Disadvantage of Computer: 

Virus and hacking attacks: 

Virus is a worm and hacking is simply an unauthorized access over computer 

for some illicit purpose. Virus is being transferred from email attachment, viewing an 

infected website advertisement, through removable device like USB etc. once virus is 

transferred in host  computer it can infect file, overwrite the file etc. 

For example: Huge portion of internet was going down including Twitter, 

Netflix, Reddit and CNN in October 2016 because the largest DDoS attack was 

launched on service provider DYN using IoT Botnet. 

 

 Online Cyber Crimes: 

Online cyber-crime means computer and network may have used in order to 

commit crime. Cyber stalking and Identity theft are the points which come under 

online cyber-crimes. 

For example: one may get the access of the access to your shopping account like 

Amazon account now that person will be able to know your personal details like debit 

card or credit card number which can be than misused. 

 Reduction in employment opportunity: 

Mainly past generation was not used of the computer or they have the 

knowledge of computer they faced a big problem when computer came in field. As we 

have seen in banking sector senior bank employees faced this problem when computer 

came to the banking sector. Above were the main disadvantages of computer, no IQ, 

Dependency, No feeling, Break down are the basic disadvantages of computer. 

 

http://ecomputernotes.com/computernetworkingnotes/services-and-applications/what-is-internet
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IPO CYCLE: 

It means input, process and output cycle. Computer perform the following 

operation in a sequence. 

1. Receives data or text 

2. Processes data 

3. Outputs result 

This cycle of operations of a computer is known as Input-Process-Output cycle. 

The following figure explains this cycle 

 

   

 

we are giving A=5 and B=4 as input data through keyboard. Process is nothing 

but manipulation of data, Here the instruction is C=A+B. The output C=9 may be 

obtained on a display screen or on a printer. 

A=5 

B=4 
C=9 C=A+B 
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II - 

 

It is system software that controls the computer system. It also coordinates and  

supervises the activities of various components of the computer. As soon as the 

computer is switched on, its operating system starts functioning. 

 

Functions of Operating System: 

 Controls the computer resources like printer, keyboard, etc. 

 Executes the application programs such as word, excel, etc. 

 Informs user about wrong input or system fault. 

 Acts as an interface between the hardware and the application software. 

 Maintains priority among users 

 Provides multi-access facility 

 Provides security 

 Manages memory 

 Manages processor 

 Shares resources 

 

Classification of Operating System 

 Single user operating system 

 Multiuser operating system 

 Graphical user interface operating system 

 Multiprocessing operating system 

 Multitasking operating system 

 Multithreading operating system 

Single user operating system: 

This operating system controls only one user at a time. This operating system is used in 
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personal computers. Example for this type of operating system is DOS. 

Multiuser operating system: 

This operating system controls more than one user at a time. This operating system is 

used in networking environment. Example for this type of operating system is UNIX 

and Window NT. Graphical user interface operating system: 

It has the capability of using graphical devices such as mouse. Examples for this 

type of operating system are Windows XP and Windows 2000. 

Multiprocessing operating system: 

It  allows  more  than  one  processor  for simultaneous processing. Examples for 

this type of operating system are UNIX and Windows NT. 

Multitasking Operating System: 

It allows multiple software processes to be run at the same time. Examples for this 

type of operating system are Windows 98, Windows 2000 and Windows XP. 

Multithreading operating system: 

It allows different part of a software program to run in parallel. Examples for 

this type of operating system are Windows 98, Windows 2000 and Windows NT. 
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III - Components of a Computer System 

CPU 

 

 

1. Input unit 

2. Central processing unit 

i. Memory unit 

ii. Arithmetic and logic unit 

iii. Control Unit 

3. Output unit 

 

Input Unit: 

These components help users enter data and commands into a computer system. Data 

can be in the form of numbers, words, actions, commands, etc. The main function of 

input devices is to direct commands and data into computers. Computers then use their 

CPU to process this data and produce output. 

For example, a laptop’s keyboard is an input unit that enters numbers and characters. 

Similarly, even a mouse can be an input unit for entering directions and commands. 

Other examples include barcode readers, Magnetic Ink Character Readers (MICR), 

Secondary Memory 

Output Input 

MMU 

CU 

ALU 

https://www.toppr.com/guides/computer-aptitude-and-knowledge/basics-of-computers/number-systems/
https://www.toppr.com/guides/english/vocabulary/words/
https://www.toppr.com/guides/computer-aptitude-and-knowledge/basics-of-computers/input-and-output-devices/
https://www.toppr.com/guides/computer-aptitude-and-knowledge/basics/keyboard-shortcuts/


  

23 

 

 

Optical Character Readers (OCR), etc. 

Another example of input devices is touch-screens. Users can simply touch these 

screens without using any other device to enter commands. From smart phones to 

ATM machines, these input devices are becoming very popular these days. 

 

Central Processing Unit (CPU): 

After receiving data and commands from users, a computer system now has to 

process it according to the instructions provided. Here, it has to rely on a component 

called the central processing unit. The CPU further uses these three elements: 

 

a) Memory Unit: 

Once a user enters data using input devices, the computer system stores this data in its 

memory unit. This data will now remain here until other components of CPU process 

it. The memory unit uses a set of pre-programmed instructions to further transmit this 

data to other parts of the CPU. 

 

b) Arithmetic and Logic Unit: 

Actual data processing occurs in this unit. All arithmetic and logical operations such as 

addition, subtraction, comparison, etc. are performed here. It has many sub units. They 

are 

Registers: It is used for temporary storage. Some of the registers are instruction 

registers, address  registers, etc. 

Program Counter: It is used to store the address of the instruction that is to be executed. 

Adders: It is used to perform arithmetic and logical operations 

 

c) Control Unit: 

This unit is the backbone of computers. It is responsible for coordinating tasks between 

all components of a computer system. The control unit collects data from input units 

https://www.toppr.com/guides/general-awareness/financial-reforms-and-banking-innovation/trends-in-banking/
https://www.toppr.com/guides/physics/units-and-measurements/
https://www.toppr.com/guides/computer-aptitude-and-knowledge/basics-of-computers/computer-memory/
https://www.toppr.com/guides/business-mathematics-and-statistics/sets-relations-and-functions/basic-definitions-and-concepts/
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and sends it to processing units depending on its nature. Finally, it also further 

transmits processed data to output units for users. 

Main memory unit: 

It holds all data and instructions temporarily. It is otherwise called primary memory or 

internal memory. There are two types of main memory. They are 

 Random-Access Memory (RAM) 

 Read-Only Memory (DRAM) 

Random-Access Memory: 

It is a volatile memory. So this type of memory loses its contents when the power is 

turned off. There are two type of RAM. They are 

 Static RAM (SRAM) 

 Dynamic RAM (DRAM) 

Dynamic RAM contents are refreshed thousands of times per second whereas Static 

RAM contents are refreshed less often. 

Read-Only Memory: 

It is nonvolatile memory, so its contents are not lost when the power is turned off. This 

memory contains the programs, which are used to boot the computer system. The 

content of ROM is recorded while manufacturing. The other types ROM are 

 PROM 

 EPROM 

 EEPROM 

PROM: It stands for programmable ROM. The user records its contents only one 

time. EPROM: It stands for erasable programmable ROM. The contents of EPROM 

are removed by focusing the chip to ultra violet light. 

EEPROM:It stands for electrically erasable programmable ROM. Its contents are 

removed by applying electrical charge. 
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Difference between RAM and ROM memory: 

 

RAM ROM 

The contents will be lost when the 

poser goes off 

The contents is permanent even when 

the poser goes off 

Accessing speed is large Assessing speed is short 

Requires high power Requires low power 

Used in large systems Used in small systems 

 

Output Unit: 

The third and final component of a computer system is the output unit. After 

processing of data, it is converted into a format which humans can understand. After 

conversion, the output units display this data to users. Examples of output devices 

include monitors, screens, printers and speakers. Thus, output units basically 

reproduce the data formatted by the computer for users’ benefit. 

 

 

These devices are used to enter information and instructions into a 

computer for storage or processing and to deliver the processed data to a user. 

Input/ Output devices are required for users to communicate with the computer. 

In simple terms, input devices bring information INTO the computer and output 

devices bring information OUT of a computer system. These input/ output 

devices are also known as peripherals since they surround the CPU and memory 

of a computer system. 

INPUT DEVICES 

An input device is any device that provides input to a computer. There are 
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many input devices, but the two most common ones are a keyboard and mouse. 

Every key  

 

press on the keyboard and every movement or click you make with the 

mouse sends a specific input signal to the computer. 

 

Following are some of the important input devices which are used in a computer 

 Keyboard 

 Mouse 

 Joy Stick 

 Light pen 

 Track Ball 

 Scanner 

 Graphic Tablet 

 Microphone 

 Magnetic Ink Card Reader(MICR) 

 Optical Character Reader(OCR) 

 Bar Code Reader 

 Optical Mark Reader(OMR) 

 

Keyboard: 

Keyboard is the most common and very popular input device which helps to input data 

to the computer. The layout of the keyboard is like that of traditional typewriter, 

although there are some additional keys provided for performing additional functions. 

Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 keys 

or 108 keys are also available for Windows and Internet. 
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The keys on the keyboard are as follows: 

 

 Keys & Description 

 

Typing Keys 

These keys include the letter keys (A-Z) and 

digit keys (09) which generally give the same 

layout as that of typewriters. 

 

Numeric Keypad 

It is used to enter the numeric data or cursor movement. 

Generally, it consists of a set of 17 keys that are laid 

out in the same configuration used by most adding 

machines and calculators. 

 

Function Keys 

The twelve function keys are present on the keyboard 

which are arranged in a row at the top of the keyboard. 

Each function key has a unique meaning and is used 

for some specific purpose. 

 

Control keys 

These keys provide cursor and screen control. It 

includes four directional arrow keys. Control keys also 

include Home, End, Insert, Delete, Page Up, Page 

Down, Control(Ctrl), Alternate(Alt), Escape(Esc). 
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Special Purpose Keys 

Keyboard also contains some special purpose keys 

such as Enter, Shift, Caps Lock, Num Lock, Space bar, 

Tab, and Print Screen. 

 

Mouse: 

Mouse is the most popular pointing device. It is a very famous cursor-control device 

having a small palm size box with a round ball at its base, which senses the movement 

of the mouse and sends corresponding signals to the CPU when the mouse buttons are 

pressed. 

Generally, it has two buttons called the left and the right button and a wheel is present 

between the buttons. A mouse can be used to control the position of the cursor on the 

screen, but it cannot be used to enter text into the computer. 

 

 

Advantages: 

 Easy to use 

 Not very expensive 

 Moves the cursor faster than the arrow keys of the keyboard. 

Joystick: 

Joystick is also a pointing device, which is used to move the cursor position on a 

monitor screen. It is a stick having a spherical ball at its both lower and upper ends. 
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The lower spherical ball moves in a socket. The joystick can be moved in all four 

directions. 

 

 

 

 

The function of the joystick is similar to that of a mouse. It is mainly used in Computer 

Aided Designing (CAD) and playing computer games. 

Light Pen: 

Light pen is a pointing device similar to a pen. It is used to select a displayed menu 

item or draw pictures on the monitor screen. It consists of a photocell and an optical 

system placed in a small tube. 

 

When the tip of a light pen is moved over the monitor screen and the pen button is 

pressed, its photocell sensing element detects the screen location and sends the 

corresponding signal to the CPU. 

Track Ball: 

Track ball is an input device that is mostly used in notebook or laptop computer, 

instead of a mouse. This is a ball which is half inserted and by moving fingers on the 

ball, the pointer can be moved. 
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Since the whole device is not moved, a track ball requires less space than a mouse. A 

track ball comes in various shapes like a ball, a button, or a square. 

Scanner: 

Scanner is an input device, which works more like a photocopy machine. It is used 

when some information is available on paper and it is to be transferred to the hard disk 

of the computer for further manipulation. 

Scanner captures images from the source which are then converted into a digital form 

that can be stored on the disk. These images can be edited before they are printed. 

Digitizer: 

Digitizer is an input device which converts analog information into digital form. 

Digitizer can convert a signal from the television or camera into a series of numbers 

that could be stored in a computer. They can be used by the computer to create a picture 

of whatever the camera had been pointed at. 

 

Digitizer is also known as Tablet or Graphics Tablet as it converts graphics and 

pictorial data into binary inputs. A graphic tablet as digitizer is used for fine works of 
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drawing and image manipulation applications. 

Microphone: 

Microphone is an input device to input sound that is then stored in a digital form. 

 

The microphone is used for various applications such as adding sound to a multimedia 

presentation or for mixing music. 

Magnetic Ink Card Reader (MICR): 

MICR input device is generally used in banks as there are large number of cheques to 

be processed every day. The bank's code number and cheque number are printed on 

the cheques with a special type of ink that contains particles of magnetic material that 

are machine readable. 

 

 

This reading process is called Magnetic Ink Character Recognition (MICR). The 

main advantages of MICR are that it is fast and less error prone. 

Optical Character Reader (OCR): 

OCR is an input device used to read a printed text. 
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OCR scans the text optically, character by character, converts them into a machine 

readable code, and stores the text on the system memory. 

Bar Code Readers: 

Bar Code Reader is a device used for reading bar coded data (data in the form of light 

and dark lines). Bar coded data is generally used in labeling goods, numbering the 

books, etc. It may be a handheld scanner or may be embedded in a stationary scanner. 

 

Bar Code Reader scans a bar code image, converts it into an alphanumeric value, 

which is then fed to the computer that the bar code reader is connected to. 

Optical Mark Reader (OMR): 

OMR is a special type of optical scanner used to recognize the type of mark made by 

pen or pencil. It is used where one out of a few alternatives is to be selected and 

marked. 

 

It is specially used for checking the answer sheets of examinations having multiple 

choice questions. 
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- 

 

Following are some of the important output devices used in a computer. 

 Monitors 

 Graphic Plotter 

 Printer 

 

Monitors: 

Monitors, commonly called as Visual Display Unit (VDU), are the main output device 

of a computer. It forms images from tiny dots, called pixels that are arranged in a 

rectangular form. The sharpness of the image depends upon the number of pixels. 

There are two kinds of viewing screen used for monitors. 

 Cathode-Ray Tube (CRT) 

 Flat-Panel Display 

Cathode-Ray Tube (CRT) Monitor: 

The CRT display is made up of small picture elements called pixels. The smaller the 

pixels, the better the image clarity or resolution. It takes more than one illuminated 

pixel to form a whole character, such as the letter ‘e’ in the word help. 
 

A finite number of characters can be displayed on a screen at once. The screen can be 

divided into a series of character boxes - fixed location on the screen where a standard 

character can be placed. Most screens are capable of displaying 80 characters of data 

horizontally and 25 lines vertically. 
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Some disadvantages of CRT: 

 Large in Size 

 High power consumption 

 

Flat-Panel Display Monitor: 

The flat-panel display refers to a class of video devices that have reduced volume, 

weight and power requirement in comparison to the CRT. You can hang them on walls 

or wear them on your wrists. Current uses of flat-panel displays include calculators, 

video games, monitors, laptop computer, and graphics display. 

 

 

 

 

The flat-panel display is divided into two categories 

Emissive Displays − Emissive displays are devices that convert electrical energy 

into light. For example, plasma panel and LED (Light-Emitting Diodes) 

Non-Emissive Displays − Non-emissive displays use optical effects to convert sunlight 

or light from some other source into graphics patterns. 

For example, LCD (Liquid-Crystal Device) 

Printers: 

Printer is an output device, which is used to print information on paper. 

There are two types of printers 

 Impact Printers 

 Non-Impact Printers 
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Impact Printers: 

Impact printers print the characters by striking them on the ribbon, which is then pressed 

on the paper. 

Characteristics of Impact Printers: 

 Very low consumable costs 

 Very noisy 

 Useful for bulk printing due to low cost 

These printers are of two types 

 Character printers 

 Line printers 

Character Printers 

Character printers are the printers which print one character at 

a time. These are further divided into two types: 

 Dot Matrix Printer(DMP) 

 Daisy Wheel 

Dot Matrix Printer 

In the market, one of the most popular printers is Dot Matrix Printer. These printers 

are popular because of their ease of printing and economical price. Each character 

printed is in the form of pattern of dots and head consists of a Matrix of Pins of size 

(5*7, 7*9, 9*7 or 9*9) which comes out to form a character which is why it is called 

Dot Matrix Printer. 
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Daisy Wheel 

Head is lying on a wheel and pins corresponding to characters are like petals of Daisy 

(flower) which is why it is called Daisy Wheel Printer. These printers are generally 

used for word- processing in offices that require a few letters to be sent here and there 

with very nice quality. 

 

Line Printers 

Line printers are the printers which print one line at a time. 

 

 

 

These are of two types 

 Drum Printer 

 Chain Printer 

Drum Printer 

This printer is like a drum in shape hence it is called drum printer. The surface of the 

drum is divided into a number of tracks. Total tracks are equal to the size of the paper, 

i.e. for a paper width of 132 characters, drum will have 132 tracks. A character set is 

embossed on the track. Different character sets available in the market are 48 character 

set, 64 and 96 characters set. One rotation of drum prints one line. Drum printers are 

fast in speed and can print 300 to 2000 lines per minute. 



37 

[Type here]  

 

Advantages 

Very high speed 

Disadvantages 

Very expensive 

Characters fonts cannot be changed 

Chain Printer 

In this printer, a chain of character sets is used; hence it is called Chain Printer. A 

standard character set may have 48, 64, or 96 characters. 

Advantages 

Character fonts can easily be changed. 

Different languages can be used with the same printer. 

Disadvantages 

Noisy 

  

Non-impact Printers: 

Non-impact printers print the characters without using the ribbon. These printers print 

a complete page at a time, thus they are also called as Page Printers. 

These printers are of two types − 

 Laser Printers 

 Inkjet Printers 

Characteristics of Non-impact Printers 

Faster than impact 

printers They are not 

noisy 

High quality 

Supports many fonts and different character size 
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Laser Printers 

These are non-impact page printers. They use laser lights to produce the dots needed to 

form the characters to be printed on a page. 

 

 

Advantages 

Very high speed 

Very high quality 

output Good graphics 

quality 

Supports many fonts and different character size 

Disadvantages 

Expensive 

Cannot be used to produce multiple copies of a document in a single printing 

Inkjet Printers 

Inkjet printers are non-impact character printers based on a relatively new technology. 

They print characters by spraying small drops of ink onto paper. Inkjet printers 

produce high quality output with presentable features. 
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They make less noise because no hammering is done and these have many styles of 

printing modes available. Color printing is also possible. Some models of Inkjet 

printers can produce multiple copies of printing also. 

Advantages 

High quality printing 

More reliable 

Disadvantages 

Expensive as the cost per page is 

high Slow as compared to laser 

printer 
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- Memory Handling 

As we know that memory is that which stores the programs and these programs are used by the 

CPU for processing. Moreover, there are two types of memories first is the logical memory and 

second is the physical memory. The memory which is temporary such as ram is also known as the 

temporary memory and the memory which is permanent such as the hard disk is also known as 

the physical memory of the system. 

When we want to execute any programs then that programs must be brought from the physical 

memory into the logical memory. So that we use the concept of memory management, this is the 

responsibility of the operating system to provide the memory spaces to every program. Also, 

manage which process will be executed at that time. 

Operating system translates the physical address into the logical address, and if he wants to 

operate, then he must translate the physical address into the logical address. This is the also known 

as binding. Means when a physical address is mapped or convert into the logical address, and then 

this is called as the binding. 

There is also a concept which is also known as the dynamic loading, in this, a program doesn’t 

reside into the memory of the computer, and we must have to load that process for processing. So 

that when a process is loaded only when a request has found, then it is called the loading of the 

process. 

 

MEMORY 

Computer’s memory can be classified into two types; primary memory and secondary 

memory. 

 

http://ecomputernotes.com/fundamental/disk-operating-system/what-is-operating-system
http://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
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PRIMARY MEMORY CAN BE FURTHER CLASSIFIED AS RAM AND ROM. 

RAM or Random Access Memory is the unit in a computer system. It is the place 

in a computer where the operating system, application programs and the data in current 

use are kept temporarily so that they can be accessed by the computer’s processor. It is said 

to be ‘volatile’ since its contents are accessible only as long as the computer is on. The 

contents of RAM are no more available once the computer is turned off. 

ROM or Read Only Memory is a special type of memory which can only be read 

and contents of which are not lost even when the computer is switched off. It typically 

contains manufacturer’s instructions. Among other things, ROM also stores an initial 

program called the ‘bootstrap loader’ whose function is to start the operation of computer 

system once the power is turned on. 

SECONDARY MEMORY 

RAM is volatile memory having a limited storage capacity. Secondary/ auxiliary 

memory is storage other than the RAM. These include devices that are peripheral and are 

PRIMARY MEMORY 

•RAM , ROM 

SECONDARY MEMORY

•CD,DVD
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connected and controlled by the computer to enable permanent storage of 

programs and data. 

 

 

Secondary storage devices are of two types; magnetic and optical. 

Magnetic devices include hard disks and optical storage devices are CDs, 

DVDs, Pen drive, Zip drive. 

Hard disks are made up of rigid material and are usually a stack of 

metal disks sealed in a box. The hard disk and the hard disk drive exist 

together as a unit and is a permanent part of the computer where data and 

programs are saved. These disks have storage capacities ranging from 

1GB to 80 GB and more. Hard disks are rewritable. 

COMPACT DISK 

Compact Disk (CD) is portable disk having data storage capacity 

between 650- 700 MB. It can hold large amount of information such  as 

music,  full-motion videos,  and text etc. CDs can be either read only or 

read write type. 

DIGITAL VIDEO DISK 

Digital Video Disk (DVD) is similar to a CD but has larger storage 

capacity and enormous clarity. Depending upon the disk type it can store 

several Gigabytes of data. DVDs are primarily used to store music or 

movies and can be played back on your television or the computer too. 

These are not rewritable. 

 

Magnetic Storage Device – one of the most popular types of storage used. 
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 Floppy diskette – A normal 3 ½ inch disk can store 1.44 MB of data. 

 Hard drive – An internal hard drive is the main storage device in a computer. 

An external hard drive is also known as removable hard drive. It is used to store 

portable data and backups. 

 Magnetic strip – Magnetic tape drive stores video and audio using magnetic 

tape, like tape and video tape recorders. 

 Super disk – A disk drive and diskette that can hold 120 MB and 240 MB of data. 

 Cassette tape – A magnetic storage device used for audio recording and playback. 

 Zip diskette – Like a floppy diskette but more advanced. 

Optical Storage Device – uses lasers and lights as its mode of saving and retrieving data. 

 Blu-ray disc – A digital optical storage device which was intended to replace 

the DVD format. 

 

 CD-ROM disc – An optical storage device that is read-only or cannot be 

modified nor deleted. 

 CD-R and CD-RW disc – CD-R is a recordable disc that can be written to once, 

while CD-RW is a rewritable disc that can be written to multiple times. 

 DVD-R, DVD+R, DVD-RW and DVD+RW disc – DVD-R and DVD+R are 

recordable discs that can be written to once, while DVD-RW and DVD+RW 

are rewritable discs that can be written to multiple times. The difference 

between the + and – is in the formatting and compatibility. 

Flash Memory Device – is now replacing magnetic storage device as it is 

economical, more functional and dependable. 

 Memory card – An electronic flash memory device used to store digital 

information and commonly used in mobile electronic devices. 

 Memory stick – A memory card that is removable. 

 SSD – Solid State Drive – A flash memory device that uses integrated circuit 

assemblies to save data steadily. 

 USB flash drive, jump drive or thumb drive – A small, portable storage device 

connected through the USB port. 

Online and Cloud – is now becoming widespread as people access data from 

different devices. 

 Cloud storage – Data is managed remotely and made available over a network. 
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Basic features are free to use but upgraded version is paid monthly as a per 

consumption rate. 

 Network media – Audio, Video, Images or Text that are used on a computer 

network. A community of people creates and use the content shared over the 

internet. 

Paper Storage – method used by early computers for saving information. 

 OMR – stands for Optical Mark Recognition – A process of capturing marked 

data of human from forms like surveys and tests. It is used to read 

questionnaires with multiple choices that are shaded. 

 Punch card – A piece of hard paper used to contain digital information coming 

from the perforated holes. The presence or absence of holes in predetermined 

positions defines the data. 
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Create the word document 

 
 

Before we  begin creating documents in Word, you may want to set up our  

Word  environment and become familiar with a few key tasks such as how to 

minimize and maximize the Ribbon, configure the Quick Access Toolbar, display 

the ruler, and use the Word Count and Zoom tools. 

 Right-click anywhere in the main menu. 

 Select Minimize the Ribbon in the menu that appears. This 

will toggle the Ribbon on and off. 

 

The check mark beside Minimize the Ribbon indicates that the feature is 

active. 

The new tabbed Ribbon system replaces traditional menus in Word 2007. It is 

designed to be responsive to your current task and easy to use; however, can 

choose to minimize the Ribbon if you would rather use different menus or 

keyboard shortcuts. 
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Working with TEXT  

To insert text: 

 Move our mouse to the location where we   want text to appear 

in the document. 

 Left-click the mouse. The insertion point appears. 

 Type the text We want to appear. 

To delete text: 

 Place our cursor next to the text we want to delete. 

 Press the Backspace key on our keyboard to delete text to the 

left of the cursor. 

 Press the Delete key on our keyboard to delete text to the right 

of the cursor. 

To select text: 

 Place the insertion point next to the text we want to select. 

 Left-click our mouse. While holding it down, drag our mouse 

over the text to select it. 

 Release the mouse button. we have selected the text. 

A highlighted box will appear over the selected text. 

When we Select text or images in Word, a hover toolbar with formatting 

options appears. This makes formatting commands easily accessible, which 

can save Our   time. 
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To copy and paste text: 

 Select the text we want to copy. 

 Click the Copy command on the Home tab. 

 Place the insertion point where we   want text to appear. 

 Click the Paste command on the Home tab. The text will appear. 

 

To drag and drop text: 

 Select the text you want to copy. 

 Left-click your mouse, and drag the text to the location where y 

we want it to appear. The cursor will have a text box underneath 

it to indicate that we  are moving text. 
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How to save documents 
 

 

 

 
 

t's important to know how to save the documents working with. There are many 

ways you share and receive documents, which will affect how We   need to 

save the file. 

 

Are We downloading the document? Saving it for the first time? Saving it as 

another name? Sharing it with someone who doesn't have Word 2007? All of 

these factors will affect how WE save Word documents. In this lesson we  will 

learn how to use the Save and Save As commands, how to save as a Word 97-

2003 compatible document, and how to save as a PDF. 

 

To use the Save As command: 

 Click the Microsoft Office button. 

 Select Save As Word Document. The Save As dialog box 

appears. 
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 Select the location where you want to save the document using 

the drop-down menu. 

 Enter a name for the document. 

 
 Click the Save button. 

To use the Save command: 

 Click the Microsoft Office button. 

 Select Save from the menu. 
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Using the Save command saves the document in its current location using the same file name. 

If you are saving for the first time and select Save, the Save As dialog box will appear. 

To Save As a Word 97 - 2003 document: 

 Click the Microsoft Office button. 

 Select Save As Word 97-2003 Document. 

 
 Select the location where you want to save the document using 

the drop-down menu. 

 Enter a name for the document. 

 Click the Save button. 
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To create a new blank document: 

 

I 

 

In addition to working with existing documents, we  will want to be able 

to create new documents. Each time you open Word, a new blank document 

appears; however, we  will also need to know how to create new documents 

while an existing document is open.  

 

In this lesson, we will learn how to create new documents—including templates 

and blank documents—via the Microsoft Office button. 

To create a new blank document: 

 Click the Microsoft Office button. 

 Select New. The New Document dialog box appears. 

 Select Blank document under the Blank and recent section. It 

will be highlighted by default. 

 

 Click Create. A new blank document appears in the Word 

window. 
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We  can access templates that are installed on our computer or on Office 

Online. Click the Microsoft Office button and select New. . 
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Formatting text 
 

 
 

To create and design effective documents, we  need to know how to format 

text. In addition to making our document more appealing, formatted text can 

draw the reader's attention to specific parts of the document and help 

communicate our message. 

In this lesson, we will learn to format the font size, style, and color of text, as 

well as how to use the Bold, Italic, Underline, and Change Case commands. 

 

F ORMAT TEXT. 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font size box on the 

Home tab. The font size drop-down menu appears. 

 Move your cursor over the various font sizes. A live preview of 

the font size will appear in the document. 
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 Left-click the font size you want to use. The font size will 

change in the document. 

To format font style: 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font style box on 

the Home tab. The font style drop-down menu appears. 

 Move your cursor over the various font styles. A live preview of 

the font will appear in the document. 



55 

[Type here]  

 

 
 Left-click the font style you want to use. The font style will 

change in the document. 

To use the Bold, Italic, and Underline commands: 

 Select the text you want to modify. 

 Click the Bold, Italic, or Underline command in the Font 

group on the Home tab. 

  

To format font colour: 

 Select the text you want to modify. 
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 Left-click the drop-down arrow next to the font colour box on 

the Home tab. The font colour menu appears. 

 Move your cursor over the various font colours. A live preview 

of the colour will appear in the document.

 
 Left-click the font colour we want to use. The font colour will 

change in the document. 

 

 

To change the text case: 

 Select the text you want to modify. 

 Click the Change Case command in the Font group on the 

Home tab. 

 Select one of the case options from the list. 
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To change text alignment: 

 Select the text you want to modify. 

 Select one of the four alignment options from the Paragraph 

group on the Home tab. 

o Align Text Left: Aligns all of the selected text to the 

left margin 

o Center: Aligns text an equal distance from the left and 

right margins 

o Align Text Right: Aligns all of the selected text to the 

right margin 

o Justify: Aligns text equally to the right and left margins; 

used in many books, newsletters, and newspapers 
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Header and footer 

 
 

We  can make your document look professional and polished by utilizing the 

header and footer sections. The header is a section of the document that 

appears in the top margin, while the footer is a section of the document that 

appears in the bottom margin. Headers and footers generally contain 

information such as page number, date, and document name. 

 

To insert a header or footer: 

 
 Select the Insert tab. 

 Click either the Header or Footer command. A menu appears 

with a list of built-in options you can use. 

 Left-click one of the built-in options, and it will appear in the 

document.OR 

 Left-click Blank to select it. 
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 The Design tab with Header and Footer tools is active. 

 
 Type information into the header or footer. 

 

  

 With the header or footer section active, click the Date & 

Time command. 
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 Select a date format in the dialog box that appears. 

 
 Click OK. The date and time now appear in the document. 

Other header and footer options 

There are many other header and footer options you can use to design these 

sections of your document. From the Header and Footer Tools Design tab, 

you can see all of your design options. 
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Inserting and modifying tables 
  

To convert existing text to a table: 

 Select the text you want to convert. 

 Select the Insert tab. 

 Click the Table command. 

 Select Convert Text to Table from the menu. A dialog box 

appears. 

 
 Choose one of the options in the Separate text at: section. This 

is how Word knows what text to put in each column. 



62 

[Type here]  

 

  
 Click OK. The text appears in a table. 

To add a row above an existing row: 

 Place the insertion point in a row below the location where you 

want to add a row. 

 
 Right-click the mouse. A menu appears. 

 Select Insert Insert Rows Above. 



63 

[Type here]  

 

 

A new row appears above the insertion point. 

 

You can also add rows below the insertion point. Follow the same steps, but 

select Insert Rows Below from the menu. 

To add a column: 

 Place the insertion point in a column adjacent to the location 

where want the new column to appear. 

 Right-click the mouse. A menu appears. 

 Select Insert Insert Columns to the Left or Insert Columns 

to the Right. A new column appears. 

To delete a row or column: 

 Select the row or column. 

 Right-click our mouse, and a menu appears. 
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 Select Delete Columns or Delete Rows. 

To apply a table style: 

 Select the table. A Table Tools Design tab now appears on the 

Ribbon. 

 Select the Design tab to access all of the Table 

Styles and Options. 

 
 Click through the various styles in the Table Styles section. 

 Left-click a style to select it. The table style will appear in the 

document. 

 

You can modify which table styles are displayed. In the Table Styles 

Options, you can select and deselect various table options. For example, ywe 

can select banded rows, and only tables with banded rows will appear in the 

Tables Styles section. 

Want to have a little more creative freedom when it comes to formatting our 

tables? We can manually change the table border or shading, change line 

weight, or erase part of the table. 
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To insert a blank table: 

 Place your insertion point in the document where we want the 

table to appear. 

 Select the Insert tab. 

 Click the Table command. 

 Drag your mouse over the diagram squares to select the number 

of columns and rows in the table. 

 
 Left-click your mouse, and the table appears in the document. 

 Enter text into the table. 

Modifying a table using the layout tab 

When you select a table in Word 2007, Design and Layout tabs appear 

under Table Tools on the Ribbon. Using commands on the Layout tab, you 

can make a variety of modifications to the table, including: 

 Adding and deleting columns 
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 Adding and deleting rows 

 Changing the cell size 

 Aligning cell text 

 Changing text direction 

 Merging and splitting cells 

 

Mail merge 

 
Mail Merge is a useful tool that will allow we to easily produce multiple letters, 

labels, envelopes, and more using information stored in a list, database, or 

spreadsheet. In this lesson, we  will learn how to use the Mail Merge 

Wizard to create a data source and a form letter, and explore other wizard 

features. Additionally, learn how to use the Ribbon commands to access Mail 

Merge tools outside of the wizard. 

To use Mail Merge: 

 Select the Mailings on the Ribbon. 

 Select the Start Mail Merge command. 

 
 Select Step by Step Mail Merge Wizard. 
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The Mail Merge task pane appears and will guide you through the six main steps to complete 

a merge. You will have several decisions to make during the process. The following is an 

example of how to create a form letter and merge the letter with a data list. 

Steps 1-3 

 Choose the type of document you want to create. In this 

example, select Letters. 

 Click Next:Starting document to move to Step 2. 

 Select Use the current document. 

 Click Next:Select recipients to move to Step 3. 

 Select the Type a new list button. 

 Click Create to create a data source. The New Address 

List dialog box appears. 

 Click Customize in the dialog box. The Customize 

Address List dialog box appears. 

 Select any field you do not need, and click Delete. 

 Click Yes to confirm that you want to delete the field. 

 Continue to delete any unnecessary fields. 

 Click Add. The Add Field dialog box appears. 

 Enter the new field name. 

 Click OK. 

 Continue to add any fields necessary. 

 Click OK to close the Customize Address List dialog 

box. 
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To customize the new address list: 

 

 Enter the necessary data in the New Address List 

dialog box. 

 Click New Entry to enter another record. 

 Click Close when you have entered all of your data 

records. 

 Enter the file name you want to save the data list as. 

 Choose the location where you want to save the file. 

 Click Save. The Mail Merge Recipients dialog box 

appears and displays all of the data records in the list. 

 Confirm that the data list is correct, and click OK. 

 Click Next:Write your letter to move to Step 4. 

Steps 4-6 

 Write a letter in the current Word document, or use an open 

existing document. 
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To insert recipient data from the list: 

 Place the insertion point in the document where 

you want the information to appear. 

 Select Address block, Greeting line, or 

Electronic postage from the task pane. A dialog 

box with options will appear based on your 

selection. 

 
OR 

o Select More Items. The Insert Merge Field dialog box 

will appear. 

o Select the field you want to insert in the document. 

o Click Insert. Notice that a placeholder appears where 

information from the data record will eventually appear. 

o Repeat these steps each time you need to enter 

information from your data record. 

 Click Next: Preview your letters in the task pane once you have 

completed your letter. 

 Preview the letters to make sure the information from the data 

record appears correctly in the letter. 

 Click Next: Complete the merge. 

 Click Print to print the letters. 

 Click All. 
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 Click OK in the Merge to Printer dialog box. 

 Click OK to send the letters to the printer. 

The Mail Merge Wizard allows you to complete the merge process in a variety 

of ways. The best way to learn how to use the different functions in Mail Merge 

is to try to develop several of the different documents—letters, labels, and 

envelopes—using the different types of data sources. 

 
 

*****all the best***** 
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